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ABSTRACT 
 
When emergencies happen, navigation services that 
guide people to exits while keeping them away from 
emergencies are critical in saving lives. To achieve 
timely emergency navigation, early and au
detection of potential dangers, and quick response 
with safe paths to exits are the core requirements, both 
of which rely on continuous environment monitoring 
and reliable data transmission. Wireless sensor 
networks (WSNs) are a natural choice of t
infrastructure to support emergency navigation 
services, given their relatively easy deployment and 
affordable costs, and the ability of ubiquitous sensing 
and communication. Although many efforts have been 
made to WSN-assisted emergency navigation, alm
all existing works neglect to consider the hazard 
levels of emergencies and the evacuation capabilities 
of exits. Without considering such aspects, existing 
navigation approaches may fail to keep people farther 
away from emergencies of high hazard leve
would probably encounter congestions at exits with 
lower evacuation capabilities. In this proect, we 
propose  a situation-aware emergency navigation 
system, which takes the hazard levels of emergencies 
and the evacuation capabilities of exits into a
and provides the mobile users the safest navigation 
paths accordingly By guiding users following the 
descend gradient of the hazard potential field, System 
thereby can thereby achieve guaranteed success of 
navigation and provide optimal safety.   

1. INTRODUCTION 

As emergency or dangerous situations change, it 
becomes necessary to frequently update the route 
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When emergencies happen, navigation services that 
guide people to exits while keeping them away from 
emergencies are critical in saving lives. To achieve 
timely emergency navigation, early and automatic 
detection of potential dangers, and quick response 
with safe paths to exits are the core requirements, both 
of which rely on continuous environment monitoring 
and reliable data transmission. Wireless sensor 
networks (WSNs) are a natural choice of the 
infrastructure to support emergency navigation 
services, given their relatively easy deployment and 
affordable costs, and the ability of ubiquitous sensing 
and communication. Although many efforts have been 

assisted emergency navigation, almost 
all existing works neglect to consider the hazard 
levels of emergencies and the evacuation capabilities 
of exits. Without considering such aspects, existing 
navigation approaches may fail to keep people farther 
away from emergencies of high hazard levels and 
would probably encounter congestions at exits with 
lower evacuation capabilities. In this proect, we 
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system, which takes the hazard levels of emergencies 
and the evacuation capabilities of exits into account 
and provides the mobile users the safest navigation 
paths accordingly By guiding users following the 
descend gradient of the hazard potential field, System 
thereby can thereby achieve guaranteed success of 

 

As emergency or dangerous situations change, it 
becomes necessary to frequently update the route  

 
 
plans for the guided users. Path dynamics in 
traditional packet routing process typically occurs 
between delivering different packets, while such 
dynamics in the navigation process might exist all 
along for guiding single individuals. People may even 
move backward to seek broader opportunities under 
varied situations.  

There have been attempts made at guiding navigation 
using WSNs. Most, if not all, existing ap
assume the availability of locations on each sensor 
node. Knowing the locations of dangerous areas, the 
sensor network can perform easy and efficient route 
calculations to navigate internal users out of the 
emergency area. The location information
may not always be available in many realistic 
situations where emergency guidance are needed, for 
example, in an underground tunnel or coal mine, a 
complex indoor area, and so on. The requirement of 
location information largely constrains the 
applicability of existing approaches to location
environments. In addition, existing approaches 
usually do not specifically consider the impact of 
variations of dangerous areas, for example, the 
expansion, shrinking, or disappearing of areas which 
is deemed dangerous. In reality, such variations often 
degrade the effectiveness of existing designs or even 
overwhelm them. So far they haven’t take evacuation 
capability of exits into account which makes big 
impact  in real time. 

Overview: 

Recent advances in wireless sensor network (WSN) 
technologies provide us with the ability to offer 
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assume the availability of locations on each sensor 
node. Knowing the locations of dangerous areas, the 
sensor network can perform easy and efficient route 
calculations to navigate internal users out of the 
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pervasive usage of sensor networks widely deployed 
over the space of interest. The increasing study of 
WSNs aims at enabling computers to better serve 
people by automatically monitoring and interacting 
with the physical world. Existing works, however, 
largely focus on developing sensor network systems 
principally providing remote data collection. The 
possibility of interactions between the users and their 
physical environment is overlooked. 

Such interactions could significantly expand the 
capability of WSNs and thereby enhance their 
usability. 

When emergencies happen, navigation services that 
guide people to exits while keeping them away from 
emergencies are critical in saving lives. To achieve 
timely emergency navigation, early and automatic 
detection of potential dangers, and quick response 
with safe paths to exits are the core requirements, 
both of which rely on continuous environment 
monitoring and reliable data transmission. Wireless 
sensor networks (WSNs) are a natural choice of the 
infrastructure to support emergency navigation 
services, given their relatively easy deployment and 
affordable costs, and the ability of ubiquitous sensing 
and communication. 

Although many efforts have been made to WSN-
assisted emergency navigation, almost all existing 
works neglect to consider the hazard levels of 
emergencies and the evacuation capabilities of exits. 
Without considering such aspects,existing navigation 
approaches may fail to keep people farther away from 
emergencies of high hazard levels and would 
probably encounter congestions at exits with lower 
evacuation capabilities. 

Brief Description: 

We consider the scenario of navigating human beings 
on the field under emergencies, where there might be 
several dangerous areas that threaten the safety of 
human beings, People need to be guided out of the 
field while keeping away from those dangerous areas. 
Fig. 1.1 depicts such an example scenario. We 
characterize the navigation problem as a path 
planning problem and present its assumptions, 
objectives as follows. 

Assumptions: We assume an emergent field 
containing several areas of dangers, as the red areas 
shown in Fig. 1.1 The dangerous areas might emerge, 

disappear, expand, or shrink as the time passes. The 
number of dangerous areas at any time is finite. 

 

Figure : Navigation for trapped user 

A sensor network system is deployed in the field, 
where each sensor is able to detect the dangers 
distributed over the field. The sensor node triggers a 
“yes” alarm if it resides in the dangerous 
area(highlighted ovals) and triggers “no” if outside 
dangerous area. Thus, the boundary of a dangerous 
area can be outlined by pairs of neighboring 
temperature sensors with different outcomes. 

Each user carries a communicating device that can 
talk with system. By measuring the strength and 
direction of wireless signals, the user is able to track 
any targeted sensor node. Thus, the navigating route 
can be interpreted as a sequence of nodes. 

Objectives: The objective of a successful navigation 
is to plan a path for each user to one or more pre 
known exits on the field that lead to safe departure, 
bypassing all the dangerous areas. In Fig. 1.1 there is 
an exit in the fields that users are required to lead to. 
We depict such an example route that leads the 
internal user to the exit. The navigation process is 
carried out in a fully distributed manner without any 
dedicated central agents like sinks. Each user is 
handoff guided by sensors along the entire route. 

Problem Definition: To provide optimal safety for 
every smart phone user in any emergency situation by 
providing optimal path towards exits, System takes 
the hazard levels of emergencies and the evacuation 
capabilities of exits into account and provides the 
mobile users the safest navigation paths accordingly. 
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Present Work: 

As emergency or dangerous situations change, it 
becomes necessary to frequently update the route 
plans for the guided users. Path dynamics in 
traditional packet routing process typically occurs 
between delivering different packets, while such 
dynamics in the navigation process might exist all 
along for guiding single individuals [3]. People may 
even move backward to seek broader opportunities 
under varied situations. 

There have been attempts made at guiding navigation 
using WSNs. 

Most, if not all, existing approaches assume the 
availability of locations on each sensor node[1]. 
Knowing the locations of dangerous areas, the sensor 
network can perform easy and efficient route 
calculations to navigate internal users out of the 
emergency area[1]. The location information, 
however, may not always be available in many 
realistic situations where emergency guidance are 
needed, for example, in an underground tunnel or coal 
mine, a complex indoor area, and so on. The 
requirement of location information largely constrains 
the applicability of existing approaches to location-
free environments[5]. In addition, existing approaches 
usually do not specifically consider the impact of 
variations of dangerous areas, for example, the 
expansion, shrinking, or disappearing of areas which 
is deemed dangerous[5]. In reality, such variations 
often degrade the effectiveness of existing designs or 
even overwhelm them. 

So far they haven’t take evacuation capability of exits 
into account which makes big impact in real time. 

Proposed Work: 

We have arrive at the plain fact that a practical and 
efficient emergency navigation scheme should be 
situation-aware, which means that we should take into 
consideration both the hazard levels of concurrent 
emergencies and the evacuation capabilities of exits. 

Despite its importance, on the down side, we 
capitalize that it is not straightforward to design such 
a situation aware emergency navigation. It is non-
trivial to directly extending existing methods which 
inherently aim at navigating users along the paths 
with equal distances to emergencies. The main 
challenge here is how to define the safety properly, 
incorporating the impacts of both different hazard 

levels of emergencies and different capabilities of the 
exits at the same time. 

Technology used in the process: 

System takes the hazard levels of emergencies and the 
evacuation capabilities of exits into account and 
provides the mobile users the safest navigation paths 
accordingly. Here we use WSN as system’s 
backbone, along with Arduino-Uno chipset, 
Temperature sensors and Wi-Fi for user-arduino 
Communication and smartphones. 

• Arduino IDE 

The Arduino Integrated Development Environment 
(IDE) is a cross-platform application (for Windows, 
macOS, Linux) that is written in the programming 
language Java. It originated from the IDE for the 
languages Processing and Wiring. It includes a code 
editor with features such as text cutting and pasting, 
searching and replacing text, automatic indenting, 
brace matching, and syntax highlighting, and provides 
simple one-click mechanisms to compile and upload 
programs to an Arduino board. It also contains a 
message area, a text console, a toolbar with buttons 
for common functions and a hierarchy of operation 
menus. The source code for the IDE is released under 
the GNU General Public License, version 2. The 
Arduino IDE supports the languages C and C++ using 
special rules of code structuring. 

Web technology: 

Hypertext Markup Language (HTML) is the standard 
markup language for creating web pages and web 
applications. With Cascading Style Sheets (CSS) and 
JavaScript, it forms a triad of cornerstone 
technologies for the World Wide Web.Web browsers 
receive HTML documents from a web server or from 
local storage and render the documents into 
multimedia web pages. 

HTML describes the structure of a web page 
semantically and originally included cues for the 
appearance of the document. HTML elements are the 
building blocks of HTML pages. With HTML 
constructs, images and other objects such as 
interactive forms may be embedded into the rendered 
page. 

Arduino: 

The arduino is a series of small single-board 
computers developed in the United Kingdom by the 
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arduino Foundation to promote the teaching of basic 
computer science in schools and in developing 
countries. The original model became far more 
popular than anticipated,selling outside of its target 
market for uses such as robotics. Peripherals 
(including keyboards, mice and cases) are not 
included with the arduino. 

Setup: 

We have Installed the Arduino IDE, it supports 
varying platform, windows, Linux and Mac. We have 
used Windows platform. Once Arduino is installed it 
is time to test ESP8266 wifi Shield . We have 
connected the Arduino board using USB cable to your 
computer for continuous power suply. The computer 
should detect this automatically. 

• Select the correct board from : Tools->Board-> 
Generic ESP8266 Module. 

• The next step is to select the port where your 
Arduino board is connected to, so go to : Tools->Port. 

• Once you have this components connected , you can 
test the connection and the board by loading the 
program sketch : 

Select File->Examples->basics ->blink. 

This will open the main sketch, you can click on the 
”Upload” button to upload your sketch. If all goes 
well then your module will work perfectly. 

The temperature sensor LM35 have 3 legs, the first 
leg is VCC, you can connect this to the 3.3V 
(ESP8266 board’s output is 3.3V). The middle leg is 
Vout (where the temperature is read from, you can 
connect this to the analog input of the 

ESP8266 pin AD0, this is located at the top right hand 
side of the board as shown in picture. And the right 
leg should be connected to the ground. Now your 
circuit is complete. 

4. CONCLUSION: 

This system conducts the first work on situation-
aware emergency navigation by considering a more 
general and practical problem, where emergencies of 
different hazard levels and exits with different 
evacuation capabilities may coexist. We first model 
the situation-aware emergency navigation problem 
and formally define the safety of a navigation path.  

We are currently devoting to conducting a small-scale 
system prototype under more complex scenarios. In 
the future, we would like to explore modeling the 
hazard speed in the context of emergency navigation. 
We also plan to cooperate with the local Fire 
Department to test our prototype, e.g., in the fire-
fighting exercises, to provide more evidences on the 
real effects on user safety in real scenarios. 
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